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You must back up PETRA regularly.  If you do not, you will lose all your data – partner addresses, 
financial records – everything. 
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Chapter 1 Overview of System Manager 

The System Manager Module is used to perform functions which set up and manage the use of 
PETRA.  These functions can be quite technical, and so should be carried out by an experienced user. 

1.1 Access to System Manager 
PETRA comes with a special User ID, SYSADMIN, who has access to the System Manager Module 
(and nothing else).  The password for this user is given in the installation documentation.  
SYSADMIN is used to create other users, who can be given access to the System Manager Module by 
making them members of the SYSADMIN group.  See the chapter on Users for details of how to do 
this. 

1.2 Scope 
Some of the System Manager functions will be used only once, when PETRA is first installed.  Others, 
such as the User Maintenance functions will be used whenever someone joins or leaves the office.  
The Housekeeping functions should be performed on a regular basis as a matter of good practice. 

PETRA comes in two versions: Network, installed on a Standard Linux Server and used by many 
people at once from Windows PCs; and Standalone, installed on a PC running Microsoft Windows 
and used by one person at a time.  Some of the system management procedures are different 
depending on which version you have.  Both versions are described in this manual. 

1.3 Menu Structure 
On entry to the System Manager module, the System Manager Screen is displayed.  All procedures in 
this Guide are carried out from this screen. 

 

Figure 1-1 System Manager Screen 
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• File Menu   gives access to the Run command to install patches, the Partner Full Report 
to print all data about a Partner from the Finance, Partner and Personnel modules, and Purge 
Expired Addresses to remove unused addresses from the database. 

 

Figure 1-2 File Menu 

• Security Menu   is used to control who has access to PETRA, and the level of access that they 
have.  You can also look at the Logins and Error Logs from here. 

 

Figure 1-3 Security Menu 

• Print Management Menu   lets you set up the forms that PETRA uses to print (paper size, 
margins, and character size), including address labels.  You can examine a printer’s paper tray 
settings, which can be useful if you need to print form letters or receipts on different kinds of 
paper.  Finally, this is where you can see what reports have been printed, and purge the old files. 

 

Figure 1-4 Print Management Menu 

• Application Menu   is where you can run housekeeping functions. 

 

Figure 1-5 Application Menu 
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• Maintain Menu   is used to set up PETRA before it can be used.  It is also used to set the message 
users see when they log in, the language that dates appear in, and how the housekeeping functions 
operate. 

 

Figure 1-6 Maintain Menu 

• Petra Menu   (not shown) gives access to the other PETRA modules. 

• Help Menu   (not shown) gives access to the online help.  The Help menu also shows the current 
patch level and patch history by selecting About Petra , and can be used to file a bug report. 

1.4 Structure of this Guide 
The Guide is organised into 12 chapters. 

Chapter 1   Overview of System Manager 

Chapter 2   System Setup  explains how to set up PETRA before it is used for the first time. 

Chapter 3   Users  how to create users and give them access to what they need. 

Chapter 4   Printing  how to manage printing in PETRA. 

Chapter 5   Startup and Shutdown  how to start and stop PETRA. 

Chapter 6   Backup and Restore  how to keep your data when your computer breaks. 

Chapter 7   Housekeeping  tasks that  need to be done regularly to delete old files and 
information that is out of date. 

Chapter 8   Patches  how to check what patches have been installed, and apply new ones. 

Chapter 9   System Manager Reports  explains the reports available to the System Manager. 

Chapter 10   ODBC  how to use PETRA data in other applications, such as Microsoft Access. 

Chapter 11   Troubleshooting  answers to some possible problems, and where to go for more 
help. 

Chapter 12   Advanced Configuration  explains the more technical configuration options 
which some system administrators will need to be aware of. 

 

----- End of Chapter 1 ----- 
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Chapter 2 System Setup 

Before PETRA can be used, it needs to be set up.  This involves setting parameters that relate to your 
office and options for PETRA’s behaviour.  Once these settings have been entered, you will still need 
to create users (see chapter 3) and set up each module that they will use. 

2.1 Sites 
First you must tell PETRA which Site (that is, an Area, Field, or Office) it is going to be used for.  
Most offices will only need to set up one Site – their own.  An office that handles data for two or more 
Sites (for example, a Field office that also handles the personnel administration for its Area) should 
set up each one.  Once a Site has been set up, it can be used as the Site Key for your office, and PETRA 
will automatically provide partner keys as you create new partners. 

If your Site Key is not in the Available Site list (for example if you are a Regional Office) it will have 
to be created as a unit in the Personnel Module.  See Section 2.5.2 Regional Offices on page 16, and 
the Personnel User Guide. 

1. From the System Manager Screen, select Maintain then System Parameters which will 
bring up the System Parameters Maintenance Screen. 

2. From the File menu, choose Add Site .  The Installed Site List appears. 

 

Figure 2-1 Installed Site List 

3. Select your Site from the list of Available Sites, then choose the >> button to make it available 
for use. 

4. To remove a Site from the Set Up list, select it and choose the << button. 

5. Choose Close to close the screen and return to System Parameters. 

2.2 System Parameters 
To enter the System Parameters, follow these steps: 

1. From the System Manager Screen, select Maintain then System Parameters which will 
bring up the System Parameters Maintenance Screen. 
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Figure 2-2 System Parameters Maintenance Screen 

2. Enter the following fields: 

Site Key   This is the Partner Key for your office.  This is where PETRA gets the site name that 
appears at the top of all reports, and it is very important for Caleb and when creating new 
partners.  The drop-down list contains the sites that you set up in section 2.1 above. 

Important:  two offices must never have the same Site Key.  See Regional Offices on page 
16 if you have two offices working for the same Field or Area. 

Localised County Label   One of the fields of an address is called ‘County’.  This is 
appropriate in the UK, but other countries will use other names such as ‘State’, ‘Region’, 
‘Province’ or ‘Canton’.  Set this to whatever is appropriate for you, and it will appear on 
the Partner Edit Screen. 

Country    Set this to your country. 

Address Match Level   Duplicate Address Check in the Partner Module checks your database 
to see if the same address has been entered more than once.  The Address Match Level 
defines how close 2 addresses need to be before they are considered the same.  A value of 
0% would match any two addresses, regardless of their content.  A value of 100% would 
only match addresses that are totally identical.  The default of 80% should work in most 
cases. 

Mailsort Program   This is used to process mailings according to their destination, which can 
lead to lower postage costs.  The default program is ‘malb100’.  If an alternative is 
required, contact the PETRA Development Team. 

Mailsort Threshold  This defines the minimum number of items in a mailsort bundle.  If there 
are few items than the number specified here, they will be combined with the bundle for 
the nearest destination. 

Gap Labels  When printing address labels, some sites like to leave some blank labels between 
different postal zones.  Other sites view this as a waste of labels.  Here is where you 
change it. 
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Report Banner  You can have an extra page print at the beginning or end of a report showing 
who printed it. 

Gift Info Display   The Partner Edit Screen can display certain gift information for a partner.  
Tick ‘Recipient’, ‘Field’ and/or ‘Amount’ if you want users of the Partner Module to see 
this data.  Users can only see the ticked items if they have appropriate Finance access 
rights in addition to Partner access rights. 

Receipt Letter Frequency  Each partner has a setting saying how often they are to be sent 
receipt letters for their gifts.  This is where you set the default value that new partners will 
be given when they are created. 

Receipt Each Gift  Each partner has a setting saying whether they will be sent a receipt for 
each gift.  The alternative is a summary.  The default that newly-created partners are given 
is specified here. 

GL Reference  When entering transactions into the General Ledger in the Finance Module, 
there is a field called ‘Reference’.  If you tick ‘Mandatory’ here, that field must be filled 
in.  If ‘Mandatory’ is not ticked, the finance users can leave the reference blank. 

Localised Bank/Branch Code Label  Enter the name that you would use for a bank’s  branch 
code.  For example, in the UK it would be “Sort Code”; in Austria, Germany and 
Switzerland “BLZ”; and in South Africa “Branch Code”.  This appears on screens 
displaying bank account details in the Partner and Finance Modules. 

Localised Bank/Branch Code Tooltip  Enter the help text that you would like to appear for 
the Bank/Branch Code field. 

3. Choose Save to save the data, and Close to close the screen. 

2.3 Language Specifics 
Around the world, people write dates in different ways.  Take, for example, ‘1/7/99’.  In America, that 
means the 7th of January, while in England, it means the 1st of July.  Most people would assume it 
refers to the year 1999, but it could equally mean 2099 or indeed any other century. 

PETRA gets around this by always displaying dates in an internationally recognisable format: ‘1-JUL-
1999’.  In Language Specifics, you can enter the names of the months in your own language, so that 
your users do not have to use the English versions. 

2.3.1 Creating Month Names for your Language 
1. Go to the Language Specifics List Screen by selecting Maintain and Language 

Specifics . 
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Figure 2-3 Language Specifics List 

2. Choose the New button, which will bring up the Language Specifics Maintenance Screen. 

 

Figure 2-4 Language Specifics Maintenance Screen 

3. Enter the data in the fields as required: 

Language Code   Select the code for your language. 

Full Name   Enter the full name of each month in your language. 

Abbr    Enter the abbreviated name of each month in your language e.g. Jan for January. 

4. Choose Save to save the data, and Close to close the screen. 

2.3.2 Editing Existing Month Names 
1. From the System Manager Screen select  Maintain and Language Specifics . 

2. Highlight the language you wish to edit and choose the Edit button. 

3. Edit the data as described in Section 2.3.1 above. 

4. To save the data, choose Save then Close . 
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2.3.3 Deleting Month Names 
1. From the System Manager Screen select  Maintain and Language Specifics . 

2. Hightlight the language you wish to delete and choose the Delete button, The Confirm Delete 
Box will ask Do you really want to delete it?  If you are sure you want to, choose Yes . 

2.4 Logon Message 
When a user logs on to PETRA, a message is displayed on the Petra Main Menu.  This is normally 
‘Welcome to Petra’, but you can change it to anything you want, and even have different messages for 
users who speak different languages. 

2.4.1 Creating a New Logon Message 
1. From the System Manager Screen, select Maintain then Logon Message .  This will bring 

up the Logon Message List Screen showing the messages in each language. 

 

Figure 2-5 Logon Message List Screen 

2. Choose New to bring up the Logon Message Maintenance Screen. 

 

Figure 2-6 Logon Message Maintenance Screen 

3. Enter the Language Code for your message, or select it from the list. 

4. Type the text for your logon message in the large box. 
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5. To save it, choose Save then Close . 

2.4.2 Editing a Logon Message 
1. From the System Manager Screen, select Maintain then Logon Message .  This will bring 

up the Logon Message List Screen showing the messages in each language. 

2. Highlight the message you wish to edit and choose Edit to bring up the Logon Message 
Maintenance Screen. 

3. Edit the message. 

4. Choose Save to save your changes, then Close . 

2.5 Module Setup 
The individual modules with PETRA also need to be set up.  Before you can do that, however, you will 
need to create users to access them, as discussed in the next chapter.  The additional setup steps are: 

• Finance & Ledger 

• Regional Offices 

• Departments 

2.5.1 Finance & Ledger Setup 
This is described fully in the Finance User Guide.  If you are a Regional Office, set up the Finance 
Module with the ledger for your Main Office. 

2.5.2 Regional Offices 
Some fields consist of more than one office, for example Finance and Personnel may be located in 
different places, or you may have one or more other offices as well as your Main Office.  A Finance 
office will normally be the Main Office with the field’s standard Site Key, while a Personnel Office 
should be set up as a Regional Office.  Regional Offices need to be created as new Units relating to 
your Main Office.  The full instructions for creating new Units are found in the Personnel User Guide, 
but there are some special requirements for Regional Offices: 

Partner Key   must have the same ledger number (the first 4 digits) as the Main Office, have one 
digit to identify the office and end with 00000.  For example, the Swiss Office is ledger 0035.  If 
they were to set up a Regional Office in Zurich, it could be given the key 0035200000.  Other 
offices would be 0035300000, 0035400000 etc. 

Partner Class   must be Unit. 

Special Type   Offices should have a Special Type of COSTCENTRE. 

Unit Hierarchy    The Regional Office must be a Child Unit of the Main Office. 

Finance Ledger   In the Finance Module, select Ledger then Setup then Cost 
Centres then Link to Partner .  The Valid Foreign Ledgers List will appear.  Highlight 
the Regional Office Unit and choose Add .  On the Maintenance Screen that appears enter a Cost 
Centre number with a Type of Local . 

Receipt Number   If a Regional Office is receipting gifts, the receipt numbers should probably 
have a different starting point from the Main Office. 

Site Key   If you are the Regional Office, don’t forget to set your site key when you have 
finished. 
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For consolidation at the Main Office, any Regional finance data will either be summarised and sent to 
the Main Office to be entered manually, or exported as batches which can be imported into the Main 
system. 

2.5.3 Departments 
Some fields prefer to have their Office split into Departments, and use the Personnel Commitment 
Record to assign individuals to these Departments.  This allows financial reporting through 
department to see if each department is covering both ministry and personal living costs.  Fields 
where living costs are pooled should not need this feature. 

To set up Departments, create each one as a new Unit under your Office, according to the instructions 
in the Personnel User Guide.  These Units should have the following characteristics: 

Partner Key   use the default Partner Key given on the New Partner Screen. 

Partner Class   must be Unit. 

Special Type   Departments should have a Special Type of COSTCENTRE. 

Unit Hierarchy    Departments should be Child Units to your Office. 

Finance Ledger   In the Finance Module, select Ledger then Setup then Cost 
Centres then Link to Partner .  The Valid Foreign Ledgers List will appear.  Highlight 
the Department Unit and choose Add .  On the Maintenance Screen that appears enter a Cost 
Centre number with a Type of Local . 

2.6 Housekeeping and Reminders 
Housekeeping functions (see Chapter 7) and Partner Reminders (see the Partner User Guide) need to 
be run regularly. 

2.6.1 Housekeeping and Reminders – Network Version 
Configure how often you want to run housekeeping using the Housekeeping  option on the 
sysadm petra22  menu.  Reminders are automatically processed early every morning. 

2.6.2 Housekeeping and Reminders – Standalone Versi on 
Reminders are run automatically when you log in to PETRA.  Both Housekeeping and Reminders can 
be run manually from the Windows Start menu, Programs ► Petra 2.2 .  Running 
Reminders from the Windows Task Scheduler is not recommended, because attempting to send email 
while the computer is in a locked state can have unpredictable effects. 

 

----- End of Chapter 2 ----- 
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Chapter 3 Users 

Each person who uses PETRA must have their own User ID and password.  The User ID controls what 
they have access to within PETRA.  There are two special User IDs that come with PETRA: 

• GUEST   This user has very limited access.  It can view, but not change any data. 

• SYSADMIN    This has already been discussed.  It does not have access to any of the PETRA 

modules, but is used to set up and maintain the system. 

Other users must be created by the System Manager. 

There are two different kinds of things a PETRA user can have access to: screens, and data.  For 
example, the easiest way to stop a member of the Personnel Department from looking at confidential 
financial data is to stop them using any of the Finance Module screens.  However, people in the 
Finance Department may need to look up addresses, so they would have access to Partner Module 
screens – but only to read the data, not change it.  Similarly, the Finance Manager should be able to 
create new accounts, but a data entry clerk should not. 

PETRA is big, so it would be very complicated (and boring) if you had to go through every screen and 
data table each time you created a new user, giving and restricting access.  Fortunately, PETRA 

provides two ways to make this much easier: modules and groups. 

3.1 Modules 
You will already be familiar with the terms ‘Partner Module’, ‘Finance Module’ and so on.  A module 
is a group of PETRA screens.  If a user has access to a module, they can use all the screens in that 
module.  The full list of modules can be seen on the Module List Screen by selecting Security 
then Modules . 

 

Figure 3-1 Module List Screen 

You can see that Partner and Finance have been split into two or three modules.  These represent 
different levels of access: a user of the Finance-3 module can use screens that a Finance-1 user cannot. 
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3.1.1 Ledger Modules 
You can also see in Figure 3-1 two modules called ‘Ledger0001’ and ‘Ledger0004’.  These do not 
represent groups of programs.  They represent ledgers.  When a new ledger is created in Finance, the 
person who created it can obviously use it.  But what about other users?  You may want several 
ledgers on your system, with different people using each one.  To allow ledger access to be restricted, 
each ledger also appears as a module.  If you want to let someone use a ledger, you must give them 
access both to the Finance Module and to the ledger they need.  This is fully explained later in 
‘Creating a User’.  PETRA will warn you if you forget the ledger part when you create a user. 

3.2 User Groups 
A Group is a collection of module access and data access.  Instead of setting up each user’s module 
and data access individually, you make them a member of a Group.  Then they can use everything that 
their Group can use.  If they need more, you can make them members of more Groups until they have 
what they need.  If you change the access level of a Group, everyone who is in that Group gets the 
new access too.  This can be an easy way of making sure all your Finance users have access to your 
ledger.  PETRA comes with a number of standard Groups already set up: 

Group Name Access Level 
BANKENTRY Bank Account and Credit Card entry 

CONF-USER Conference Management access 

DEVADMIN Financial Development administration 

DEVUSER Financial Development access 

FINANCE-1 Basic Finance access 

FINANCE-2 Intermediate Finance access 

FINANCE-3 Advanced Finance access 

GUEST View basic Personnel and Partner data 

PERS-ADMIN Enter and view basic Personnel data 
Configure Personnel Module 

PERS-USER Enter and view basic Personnel data 

PERS-VIEW View basic Personnel data 

PTNRADMIN Enter and view basic Partner data 
Configure Partner Module 

PTNRUSER Enter and view basic Partner data 

SYSADMIN System Manager access 

USER General access – Partner, Personnel and Finance 

3.3 Creating a User 
1. From the System Manager Screen select Security then User .  The User List Screen will 

appear. 
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Figure 3-2 User List Screen 

2. Choose New which will bring up the User Maintenance Screen. 

 

Figure 3-3 User Maintenance Screen 

3. Enter the fields required: 

User ID   must be at least 5 characters, without spaces.  Normally it will be the same as the name 
with which the user logs on to the network or to Windows.   

If you are very concerned about security, you can use a different name.  In that case even if an 
unauthorised person managed to get in to Windows, they would still not know anything about 
how to log in to PETRA – not even a user name.  See ‘Automatic Detection of User ID’ on page 
59. 

Partner Key   links the user to an existing person record.  This will automatically fill in the 
personal and family name fields.  Financial Development users need to be linked to their person 
records in order to be made Foundation Owners (see the Partner User Guide). 

Personal Name   the user’s first or personal name. 

Family Name   their surname or family name. 

Language Code   their preferred language. 

Delete System Records   not currently used. 
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Ledger Number   the ledger that the user wants to open automatically when they enter the 
Finance Module.  This only makes sense if there is more than one ledger on your system. 

Acquisition Code   new partners created by the user get the acquisition code set here.  If the user 
changes a partner’s acquisition code, the new code becomes the default and is shown here. 

4. Make sure the User ID is correct, then choose Save to create the user. 

Once the User has been saved, the ID cannot be deleted or edited.  Make sure it is correct before 
saving. 

5. Give the user a password.  Choose Maintain and Password .  The Password dialogue box 
appears. 

 

Figure 3-4 Password Dialogue 

6. Choose a password.  Passwords must be at least 5 characters, and are case sensitive.  You will not 
be able to see what you are typing, so you need to enter it in the New and Confirm boxes to 
prevent mistakes.  Press [Return]  or choose Ok when you have finished. 

Note   a common problem that prevents users logging in is having the keyboard Caps Lock turned 
on.  If the password they enter differs in any way from what they were given here, it will not work. 

7. Now you need to put the user in their groups.  Choose Maintain again and this time choose 
Group Assignments .  The Group Assignments Screen appears. 

 

Figure 3-5 Group Assignments Screen 
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Highlight all the groups you want the user to be a member of.  You can choose multiple groups by 
holding down the [Ctrl]  key as you click on them.  When you have selected all the groups you 
want, choose Add .  You will see the groups appear in the bottom part of the screen.  When you 
have finished, choose OK. 

8. If the user has Finance access, and if you have any ledgers set up, you will need to give them 
access to their ledger.  Choose Maintain and Module Access Permissions .  The 
User Module Access Permissions Screen appears. 

 

Figure 3-6 User Module Access Permissions Screen 

Scroll down the list of Available Modules until you find the ledger.  Select it and choose Add .  
You can select several ledgers by holding down [Ctrl]  as you click on them.  Choose OK 
when you have finished. 

Tip    This gives one user access to the ledger.  You may find it more convenient to give their Group 
access to it instead.  See ‘Editing a Group’ below. 

9. The user is now ready.  Close the User Maintenance Screen. 

3.4 Editing a User 
To alter an existing user: 

1. On the System Manager Screen, choose Security and User . 

2. Highlight the user you wish to edit and choose Edit . 

3. Enter the new details as described in ‘Creating a User’ on page 20. 

4. Save and Close . 

3.5 Retiring a User 
You cannot delete users once they have been created.  When a person leaves the office, you disable 
their User ID by ‘retiring’ it.  If they return, you can ‘unretire’ it. 
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1. On the System Manager Screen, choose Security and User . 

2. Highlight the user you wish to retire and choose Edit . 

3. On the User Maintenance Screen choose Retire . 

4. The Confirm Retire dialogue box appears.  Choose Yes to retire the user. 

 

Figure 3-7 Confirm Retire Box 

5. Close the User Maintenance Screen.  The user will be shown as Retired on the User List 
Screen.  A Retired user cannot log in to PETRA. 

3.6 Unretiring a User 
To re-activate a retired User ID: 

1. On the System Manager Screen, choose Security and User . 

2. Highlight the user you wish to retire and choose Edit . 

3. On the User Maintenance Screen choose Unretire . 

4. Close the User Maintenance Screen.  The user will be shown as not Retired on the User List 
Screen, and they will be able to use PETRA again. 

3.7 Changing a User’s Password 
A user can change their own password from the PETRA Main Menu by choosing Options and Change 
Password (see the General User Guide).  If a user has forgotten their password, you will have to reset 
it for them: 

1. On the System Manager Screen, choose Security and User . 

2. Highlight the user you wish to retire and choose Edit . 

3. On the User Maintenance Screen choose Maintain and Password . 

4. Enter and confirm the new password, then choose OK. 

3.8 Editing a Group 
Normally, you should not need to edit PETRA’s groups.  If you only have one ledger though, and a 
large number of users need to access it, it can be convenient to add the ledger module to your Finance 
groups. 

To add a module to a group: 

1. From the System Manager Screen, select Security and Group to see the Group List 
Screen. 
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Figure 3-8 Group List Screen 

2. Highlight the group you wish to edit.  Choose Edit to bring up the Group Maintenance Screen. 

 

Figure 3-9 Group Maintenance Screen 

3. Choose Maintain and Module Access Permissions which will bring up the Group 
Module Access Permissions Screen. 
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Figure 3-10 Group Module Access Permissions Screen 

4. Scroll down the list of Available Modules until you find the ledger you want to add, and highlight 
it.  You can select more than one ledger by holding down [Ctrl]  as you click them, but don’t 
do that unless you’re really sure that everyone in that group needs all of the chosen ledgers. 

5. Choose Add to add the ledger to the group, then OK. 

6. Close the Group Maintenance Screen. 

All users who were in this group will now have access to the ledger, and any new users who are put 
into this group will be given access to it automatically. 

 

----- End of Chapter 3 ----- 
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Chapter 4 Printing 

PETRA is capable of producing several different kinds of printed output: reports, receipts, form letters 
and labels.  These can be displayed on the screen, saved as text or html files, and emailed as well as 
being printed. 

Most reports are 132 characters wide, so they need to be printed using a small font and with small 
margins.  A few reports are even wider than this, and need to be printed in landscape format.  Letters, 
on the other hand, look best with larger font and margins.  To look after these different requirements, 
PETRA uses forms. 

4.1 Forms 
A form is a stored set of paper, margin and font settings.  Everything you print to a particular form 
comes out looking the same way.  PETRA comes with several forms built in, which allow you to print 
the standard reports and letters on common paper sizes.  If you have any other kinds of paper, such as 
pre-printed receipts, you can easily create a new form with the correct settings.  The forms and their 
descriptions can be seen on the Form List Screen by selecting Print Management then Form . 

 

Figure 4-1 Form List Screen 

4.1.1 Form to Module Assignment 
Not every PETRA module needs to be able to use every form.  For example, the only thing you can 
print from System Manager is 132-column reports.  You don’t need any of the forms designed for 
writing letters.  If the only paper size you use in your office is A4, you don’t need any of the forms 
defined for other paper sizes.  When you ask for a printout and the Start Print Job Screen appears, the 
only forms that will be available are the ones that have been assigned to the module you are printing 
from. 

Note   it is a common mistake to create a new form but forget to assign it to any modules.  If your 
new form does not appear on the Start Print Job Screen, this is the reason. 
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4.1.2 Creating a New Form 
1. From the System Manager Screen, select Print Management and Form .  The Form List 

Screen will appear. 

2. Choose New .  The Form Maintenance Screen will appear. 

 

Figure 4-2 Form Maintenance Screen 

3. Enter the data required: 

Form Name   choose a name that easily reminds you of the size and format. 

Description   enter a longer description of what this form is for. 

Unit of Measure   choose Centimeters or Inches . 

Paper Size   enter the size of the paper in the units you chose. 

Orientation    choose Portrait or Landscape . 

Margins   enter the margins you want between the edges of the paper and the start of your text.  If 
you enter 0, you will get the minimum possible margin for your printer. 

Character Spacing   enter the character size that you want as Characters per Inch and the line 
spacing as Lines per Inch.  Note that these two settings are always in inches. 

4. Save the new form. 

5. Assign it to at least one Module.  Choose Maintain and Form to Module 
Assignment .  The Modules Assigned to Form Screen appears. 



System Manager Guide  Chapter 4   Printing 

Version 2.2 (1 Nov 2007)  Page 29 

 

Figure 4-3 Modules Assigned to Form 

6. Choose Add and a list of available modules appears.  You can select more than one by holding 
down [Ctrl]  as you click on them.  Choose Ok when you have finished. 

7. Close the Modules Assigned to Form Screen. 

4.1.3 Editing a Form 
To change an existing form, follow these steps: 

1. From the System Manager Screen, choose Print Management and Form to bring up the 
Form List Screen. 

2. Highlight the form you wish to edit and choose the Edit button to open the Form Maintenance 
Screen. 

3. Enter the new details as described in ‘Creating a New Form’ above. 

4. Save and Close the Form Maintenance Screen. 

4.1.4 Deleting a Form 
To delete a form that you will not need again, follow these steps: 

1. From the System Manager Screen, choose Print Management and Form to bring up the 
Form List Screen. 

2. Highlight the form you wish to delete and choose the Delete button. 

3. The Confirm Delete Box will ask ‘Do you really want to delete it?’.  Choose Yes if you are 
sure. 

4.1.5 Assigning a Form to a Module 
This has already been discussed in ‘Creating a New Form’.  To add an existing form to more modules: 

1. From the System Manager Screen, choose Print Management and Form to bring up the 
Form List Screen. 

2. Highlight the form and Edit it. 
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3. On the Form Maintenance Screen menu, choose Maintain and Form to Module 
Assignment . 

4. The modules the form already belongs to are listed on the Form to Module Maintenance Screen.  
Choose Add to add more. 

5. Select the new modules from the list of available modules.  You can select more than one by 
holding down [Ctrl]  as you click them.  Choose Ok when you have finished. 

6. Close the Modules Assigned to Form Screen and Form Maintenance Screen. 

4.1.6 Removing a Form from a Module 
If you want to stop a form appearing in the list of forms on the Start Print Job Screen for a particular 
module, you can remove its assignment: 

1. From the System Manager Screen, choose Print Management and Form to bring up the 
Form List Screen. 

2. Highlight the form and Edit it. 

3. On the Form Maintenance Screen menu, choose Maintain and Form to Module 
Assignment . 

4. Select the modules you want to remove, and choose Delete . 

5. If you are sure this is what you want, choose Yes on the Confirm Delete Box. 

6. Close the Modules Assigned to Form Screen and Form Maintenance Screen. 

4.2 Labels 
PETRA can print addresses on sheets of sticky labels.  There are a lot of different kinds of label paper 
though, so you have to tell PETRA which ones you are using.  Label setup comes in two parts: the 
labels themselves, and the form they are printed on.  The label settings tell Petra what size the 
individual labels are and how they are laid out on the page.  The form settings, as before, give the size 
and margins of the whole page. 

Note   it is a common mistake to try to print labels on one of the standard report forms.  If you do 
this, the margins and spacing will be wrong.  Make sure you use the correct form for your labels. 

PETRA comes with two types of label paper already set up: 

Label Type Form Description 
1x8 LABEL1x8 8 labels down a sheet of 11-inch continuous 

paper, suitable for dot matrix printers. 

3x7 LABEL3x7 3 labels across and 7 down on a sheet of A4 
paper, suitable for laser printers. 

 

Note   Petra still measures label sizes as an exact number of lines high, and an exact number of 
characters wide.  Some new brands of label paper in Europe do not work using these measurements.  
Paper that does work has labels that are 63.5 x 38.1mm, such as 5 Star Laser Labels product code 
296778, or Avery Addressing Labels product code L7160. 

4.2.1 Creating Labels 
To tell PETRA about a new type of label paper, follow these steps: 
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1. Create a form with the correct paper size and margins.  See ‘Creating a New Form’ above.  The 
Form Name should tell you what it is for.  For example, if you are creating a form for 3 by 8 label 
paper, call it LABEL3x8. 

2. From the System Manager Screen, choose Print Management and Label to bring up the 
Label List Screen. 

 

Figure 4-4 Label List Screen 

3. Choose New to bring up the Label Maintenance Screen. 

 

Figure 4-5 Label Maintenance Screen 

4. Enter the settings for your labels.  Figure 4-6 shows the measurements you will need: 
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Figure 4-6 Label Measurements 

Label Code   a code for your new labels.  It should tell you what kind of paper these settings are 
for. 

Label Description   a longer description. 

Form Name   select the form these labels should be used with. 

Columns between labels   the width in characters of the gap between the columns of labels.  The 
Characters per Inch setting on the form tells you how wide each character is. 

Lines between labels   the height in lines of the gap between the rows of labels.  The Lines per 
Inch setting on the form tells you how high each line is. 

Height in Lines   the number of lines that will fit on a label, at the Lines per Inch setting of the 
form.  For example, labels 1.5 inches high would have a height of 9 lines with a 6 Lines per Inch 
form, but a height of 12 if the form had 8 Lines per Inch. 

Width in Characters   the number of characters that will fit across each label, at the Characters 
per Inch setting of the form.  For example, labels 2.5 inches wide would have a width of 40 with a 
16 Characters per Inch form, but a width of 30 with a 12 Characters per Inch form. 

Number of labels across   the number of labels across the page. 

Number of labels down   the number of labels down the page. 

5. Save and Close the Label List Screen. 

4.2.2 Editing Labels 
To change the layout of a label sheet, follow these steps: 

1. From the System Manager Screen, choose Print Management and Label to bring up the 
Label List Screen. 

2. Highlight the label you wish to change and Edit it. 

Enter the new data in the Label Maintenance Screen as described in ‘Creating Labels’ on page 30. 

3. Save and Close the Label Maintenance Screen. 
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4.2.3 Deleting Labels 
To delete labels that you are not going to use again: 

1. From the System Manager Screen, choose Print Management and Label to bring up the 
Label List Screen. 

2. Highlight the label you wish to change and Delete it.  If you are sure this is what you want to 
do, choose Yes on the Confirm Delete Box. 

3. Close the Label List Screen. 

4.3 Printer Trays 
On the Start Print Job Screen, you can specify which of your printer’s paper trays you want the print 
job to be taken from.  Sometimes, though, you need more control than this, for example if your form 
letters have two sections that need to be printed on different kinds of paper. 

The ~Ytray. command can be used in the form letter body (see the Partner User Guide for instructions 
on using form letters), but unfortunately it cannot take a tray name, only a code number.  And each 
printer, of course, has its own set of code numbers for its trays. 

From the System Manager Screen, select Print Management and Paper Trays .  Now you 
can see the tray names and code numbers for each of your printers. 

Remember   if you have set up a form letter to use a specific printer’s tray settings, it will almost 
certainly not work properly on any other printer.  If you change printers, you will have to change 
the tray codes in the form letter as well. 

4.4 Reprinting Reports 
Users can reprint their own reports in the ways described in the General User Guide.  If necessary, the 
System Manager can also reprint reports, like this: 

1. From the System Manager Screen, choose Print Management and View Report 
Files . 

2. Highlight the report you want to reprint and choose the Print button.  The Start Print Job 
Screen will appear for the report you selected. 

3. Select the options you want and choose OK. 

 

----- End of Chapter 4 ----- 
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Chapter 5 Startup and Shutdown 

This is one area where the Network and Standalone versions of PETRA are very different.  On a 
network, PETRA will be active on your server all the time.  On a standalone computer, it will normally 
be shut down unless you are using it. 

5.1 The Network Version 

5.1.1 Network Startup 
When you start your Linux server, PETRA will be started automatically.  Users will be able to connect 
to it from their workstations. 

If it has been shut down for any reason, it may be started like this: 

1. Log in to your Linux server as root . 

2. Type sysadm petra22 . 

3. Select Start .  A startup summary will be displayed. 

Note   the start option is not available from the sysadm petra22 screen if PETRA is already running. 

5.1.2 Network Shutdown 
When you shut down your Linux server, PETRA will be shut down cleanly.  If you want to shut it 
down manually, you can do so: 

1. Warn all your users, so that they can finish and work they are doing.  The Finance Department 
may not like it if you shut down while they are running a month end.  Try to avoid that. 

2. Log in to your Linux server as root . 

3. Type sysadm petra22 . 

4. Select Stop . 

5. You will be asked ‘Do you really want to shut down the database?’: choose Yes if you really 
want to shut down.  A shutdown summary will be displayed. 

Anyone who was still using PETRA will be disconnected, and any work they had not saved will be 
lost. 

Note   The stop option is not available from the sysadm petra22 screen if PETRA is already shut 
down. 

5.1.3 Logging Off a User 
If a network user’s computer crashes, the server should automatically disconnect their connection 
after a few minutes.  If this did not happen, they might receive messages like ‘Unable to edit this 
record.  Partner Edit record is being edited by another user’ when they logged back in to carry on 
what they were doing.  If necessary, you can manually disconnect a user; it is a two-stage process 
now, because we are half-way through converting from the old Progress server to the new Petra 
server, and both used by different parts of PETRA.  This is the procedure: 

1. Log in to Linux as root . 
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2. Type sysadm petra22 . 

3. Select ConnectedClients . 

 ID | Client          | Status           | Computer     | IP Address  
    | Connected since | Last activity    | Server P ort |             
----+-----------------+------------------+--------- ----+------------ 
 38 | MORAYH_38       | Idle             | dell50      | 10.10.1.166 
    | 14/11 08:22:44  | 14/11 08:22:47   | 2101        |             
 40 | MORAYH_40       | Idle             | Dell50      | 10.10.1.166 
    | 14/11 12:20:13  | 14/11 12:20:15   | 2103        |             
 42 | RICHARDP_42     | Idle             | Dell45      | 10.10.1.174 
    | 14/11 14:58:23  | 14/11 14:58:26   | 2102        |             
(Currently connected Clients: 3; client connections  since Server sta 

In this example, connection 38 is the older of MORAYH’s two connecions, and is therefore the one 
that should be disconnected. 

4. Select Exit  to return to sysadm. 

5. Select Administration  then Disconnect to disconnect them from the Petra Server. 

6. Choose the user you identified earlier (in this case number 38), and OK. 

7. Now select Monitor to disconnect them from Progress. 

8. Enter the number 8 to choose Shut Down Database to bring up a list of all users 
connected to the database, for example: 

9. Enter the number 1 to choose Disconnect a User . 

usr    pid     time of login          user id     t ty         Limbo 
 27  12546 Wed Nov 14 12:20:14 2007   petraserver             no 
 28   3948 Wed Nov 14 12:20:07 2007   MORAYH      D ell50      no 
 29  12546 Wed Nov 14 14:58:25 2007   petraserver             no 
 30   1944 Wed Nov 14 14:58:18 2007   RICHARDP    D ell45      no 
 33   1756 Wed Nov 14 08:22:36 2007   MORAYH      D ell50      no 

     1  Disconnect a User 
     2  Unconditional Shutdown 
     3  Emergency Shutdown (Kill All) 
     x  Exit 

   Enter choice> 

In this example, user number 33 corresponds to the connection we are trying to remove.. 

10. Enter the number 1 to choose Disconnect a User . 

11. Enter the number of the user you want to disconnect. 

12. Enter x to exit from that menu, then q to return to the sysadm petra22admin screen. 

13. Press [Esc]  until sysadm closes, then log off. 

Note   Accidentally disconnecting the wrong user will log them out of PETRA (and may annoy 
them), but will not damage the database. 
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5.2 The Standalone Version 

5.2.1 Standalone Startup 
To use PETRA, open the Windows Start Menu and choose Programs ► Petra 2.2 ► 
Petra 2.2 Standalone  or double-click the Petra 2.2 Standalone  icon on your desktop. 

This will start both PETRA and the ODBC server, because part of the Finance Module, Accounts 
Payable, accesses data using ODBC.  You will also be able to use other applications, such as 
Microsoft Access, to query data in Petra.  See Chapter 10 ODBC on page 55 for more information 
about using ODBC; if you think PETRA is complicated already, wait till you try it like this.   

If you want to look at your data in other applications without running PETRA, you can start the ODBC 
server manually.  Open the Windows Start Menu and choose Programs ► Petra 2.2 ► 
Start ODBC Server .  An MS-DOS window will appear briefly. 

 

Figure 5-1 Start ODBC Server Summary 

WARNING   in very old versions of PETRA, if you received a ‘database is already running’ 
message, you could delete the petra.lk file.  DO NOT do that in this version.   

5.2.2 Standalone Shutdown 
When you exit from PETRA, it closes down along with the ODBC server. 

To shut down the ODBC Server if you started it manually, open the Windows Start Menu and 
choose Programs ► Petra 2.2 ► Stop ODBC Server .  Enter 2 to choose 
Unconditional Shutdown . 

 

Figure 5-2 Stop ODBC Server Summary 

 

----- End of Chapter 5 ----- 
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Chapter 6 Backup and Restore 

You must back up PETRA regularly.  If you do not, you will lose all your data – partner addresses, 
financial records – everything. 

There are two steps involved in making a backup: 

1. Creating a backup file, petra.bak, that contains all your data. 

2. Copying petra.bak and any other files you need to keep to a tape, CD or zip-disk, and storing that 
in a fireproof safe.  Keep several versions of these files – do not just use the same tape or disk 
over and over again. 

Always use the PETRA backup commands to create petra.bak.  DO NOT use Windows Explorer, MS-
DOS copy command, Linux cp, or any other Operating System utility to try to copy any of the 
database files themselves. 

Important    in this version of PETRA, the database consists of several different files spread through 
a number of directories.  Not just two files as it was in the previous version.  We really, really mean 
it about not copying them directly. 

The procedures are different for the Network and Standalone versions. 

6.1 The Network Version 

6.1.1 Network Backup 
PETRA will be backed up by the normal overnight backup.  This will be an ‘online’ backup, which 
means that PETRA will not be shut down.  The petra.bak file is created at the start of the backup, then 
copied to tape along with everything else.  The database files themselves are not copied to tape. 

You can also make a manual backup, which gives you the option of naming the backup file.  There 
are two ways of doing it: ‘online’ where you leave the database running, and ‘offline’ where you shut 
it down first.  The advantages of an offline backup are that the backup file is smaller, you can verify 
it, and the database will start up faster if you restore from it.  With an online backup, there may be a 
delay as work that was in progress during the backup is ‘rolled back’. 

You should always make a manual backup before a financial year end and before any upgrade. 

This is how you take a backup: 

1. Log in to your Linux server as root . 

2. Type sysadm petra22 . 

3. If you want an offline backup, warn your users that PETRA is going down for a few minutes, then 
shut it down by selecting Stop . 

4. Select Backup .  You will be prompted for a file name.  Press [Return]  to accept the default 
petra.bak, or type in a new name; Linux filename completion using the [tab]  key works here.  If 
you do not specify a full path name, the file will be stored in /usr/local/petra/db22.  When the 
backup has completed a summary will be displayed. 

5. To check it, select Verify .  Note that verify only works with offline backups. 

6. If this was an offline backup, select Start to start PETRA. 
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6.1.2 Network Restore 
If you want to restore only the contents of the database, see ‘Database Restore’.  For a full system 
restore, see ‘Full Restore’. 

6.1.2.1 Database Restore 

This will restore only the contents of your database.  Report files and form letters will be left as they 
were. 

1. Log in to your Linux server as root . 

2. If restoring from the standard petra.bak, make sure that the version in /usr/local/petra/db22 is the 
one you want.  Copy it from your backup media if necessary. 

3. Type sysadm petra22 . 

4. If PETRA is running, select Stop to shut it down. 

5. Select Restore .  You will be prompted for the name of a backup file.  Press [Return]  to 
accept the default petra.bak, or type in a new name; Linux filename completion using the [tab]  
key works here.  If you do not specify a full path name, the file should be in /usr/local/petra/db22.  
If a version of Petra already exists, you will be asked ‘Do you want to over write it?’ 

6. A summary of the restore will be displayed. 

7. Select Start to start PETRA. 

6.1.2.2 Full Restore 

This will fully restore the whole of PETRA, for example if you have installed a new hard disk in your 
server. 

1. Log in to your Linux server as root . 

2. Install PETRA from the most recent PETRA Install CD. 

3. Restore these directories from your most recent backup: 

• /usr/local/petra 

• /usr/local/samba/dat/petra 

• /usr/local/samba/app/Programs/Petra2 

4. Type sysadm petra22 . 

5. Select Restore .  Press [Return]  to select the default petra.bak file.  A basic version of Petra 
was installed in step 2, which you should over write. 

6. Check the restore summary for errors, then Start PETRA. 

6.2 The Standalone Version 
Unlike the Network version, there is no option to back up PETRA automatically.  You must create 
petra.bak each day, and make sure it is included on your regular system backups. 

You should also make an extra backup before a financial year end and before any upgrade. 
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6.2.1 Standalone Backup 
1. Make sure that PETRA is completely shut down, including the ODBC Server. 

2. Create petra.bak:  Open the Windows Start Menu and choose Programs ► Petra 2.2 
► Backup Petra 2.2 .  You will be prompted for a file name; press [Return]  to accept the 
default petra.bak, or type in a new name.  If you do not specify a full path name, the file will be 
stored in Petra2\db22.  A window will appear with a summary of the backup. 

 

Figure 6-1 Backup Petra Summary 

3. Use your normal backup program to copy the entire \Petra2 folder and its subfolders to tape, CD 
or zip-disk.  This will preserve your archived reports, export files, form letters and patches along 
with petra.bak. 

6.2.2 Standalone Restore 

6.2.2.1 Database Restore 

If you only want to restore to a previous version of your data, follow these steps: 

1. If restoring from the standard petra.bak, make sure that the version in the \Petra2\db22 folder is 
the one you want.  Copy it from your backup media if necessary. 

2. Open the Windows Start Menu and choose Programs ► Petra 2.2 ► Restore 
Petra 2.2 .  You will be prompted for a file name; press [Return]  to accept the default 
petra.bak, or type in a new name.  If you do not specify a full path name, the file should be in 
Petra2\db22.   

3. A window will appear and ask if you want to over write your current data.  If that is what you 
really want to do, enter y .  A summary of the restore will appear. 

 

Figure 6-2 Restore Petra Summary 
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6.2.2.2 Full Restore 

If you need to fully restore the whole of PETRA (for example if your hard disk broke, or was erased by 
a virus) then you need to follow these steps: 

1. Install PETRA from the most recent PETRA Install CD. 

2. Restore the entire \Petra2 folder from your most recent backup. 

3. Open the Windows Start Menu and choose Programs ► Petra 2.2 ► Restore 
Petra 2.2 .  Enter the file name or [Return]  to restore petra.bak. 

4. Enter y when asked if you want to over write. 

6.2.3 Moving Petra to a Different Drive 
If you install another hard disk, or set up an encrypted drive, you may want to move PETRA to it.  The 
procedure is similar to a full restore: 

1. Back up the original version. 

2. Install PETRA from the most recent PETRA Install CD to the new drive. 

3. Copy the contents of the original \Petra2 folder except the db22 subfolder to the new drive.  It is 
important  that you keep the new versions of the files in the db subfolder. 

4. Copy the original \Petra2\db22\petra.bak file to the \Petra2\db22 folder on the new drive. 

5. Open the Windows Start Menu and choose Programs ► Petra 2.2 ► Restore 
Petra 2.2 , enter the file name if appropriate, and enter y when asked if you want to over 
write. 

6. Rename the original \Petra2 folder to \Petra2.old 

7. When you are certain that PETRA is working properly from the new drive, delete the original 
\Petra2.old folders.  Your AITA can advise you on special programs to delete data securely, if that 
is necessary: files deleted with Windows Explorer can be recovered by security experts! 

 

----- End of Chapter 6 ----- 
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Chapter 7 Housekeeping 

PETRA keeps copies of every report that is printed, and every extract that is created (to find out about 
extracts, see the Partner User Guide).  It also keeps logs of everyone who has logged in, and of certain 
errors.  All these should have old data cleared out regularly.  This can be done manually, as discussed 
in ‘System Manager Reports’ on page 51, but the easiest way to do it is to use the Housekeeping 
function. 

7.1 Housekeeping 
Before running Housekeeping, you must set it up in PETRA.  On a Network version, you can have 
Linux run it automatically, but on a Standalone you must run it yourself. 

7.1.1 Setting up Housekeeping 
1. From the System Manager Screen, select Maintain and Startup Parameters .  The 

Startup Parameters Maintenance Screen appears. 

 

Figure 7-1 Startup Parameters Maintenance Screen 

2. Choose what you want the Housekeeping to do: 

Purge Error Log    tick this if you want old entries to be cleared from the error log.  Entries older 
than the Minimum Purge Days will be deleted (in this case, everything older than 14 days.) 

Purge Logins Log   tick this if you want the log of who has logged in to PETRA to be cleared.  
Again, anything older than Minimum Purge Days is deleted. 

Purge Report Files   tick this if you want old report files to be deleted.  Once you have deleted a 
report, it cannot be reprinted, but see ‘Archiving Reports’ below to find out how to keep certain 
reports even when they are older than the Minimum Purge Days. 

Purge Extracts   tick this to remove all temporary extracts oldert than the Minimum Purge Days.  
A temporary extract is listed as Deletable on the Extract Master List and Extract Master 
Maintenance Screens. 

Run Batch Jobs   tick this to have Housekeeping run any batch print jobs.  These are created 
when you set the Run Mode to Batch on the Start Print Job Screen. 
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Note   you can create report files in this way under Linux, but they will not print out.  You must log 
in to PETRA and use the reprint procedure described earlier in ‘Reprinting Reports’. 

3. Save your settings and Close the screen. 

7.1.2 Network Housekeeping 
Running Housekeeping on the Network version will shut it down for about one minute, logging off 
any users.  When run automatically, it runs at 4 o’clock in the morning, so this is unlikely to be a 
problem.  If you choose to run it manually, it warns you that it will shut down, and asks if you want to 
continue. 

To tell Linux when you want the Housekeeping to run: 

1. Log in to Linux as root . 

2. Enter sysadm petra22 , and choose Housekeeping . 

3. Choose how often you want it to run.  Whichever options are enabled on the Startup Parameters 
Maintenance Screen are run automatically every day, week, or month, as you specify. 

4. Choose OK to return to the sysadm petra22 screen. 

When it runs, it sends an email to root with a report of what it has done. 

NOTE  Some sites may run their backup at 4 o’clock in the morning, too.  This should not cause a 
problem, but there will be errors in the backup report if it tries to back up files that Housekeeping 
has deleted.  The solution is to re-schedule the backup to an earlier time e.g. 22:00. 

7.1.3 Standalone Housekeeping 
1. Make sure that PETRA is completely shut down, including the ODBC Server. 

2. Open the Windows Start Menu and choose Programs ► Petra 2.2 ► 
Housekeeping .  As it runs, it will display its progress in an MS-DOS window. 

 

Figure 7-2 Houskeeping Summary 

3. When the Housekeeping completes, you can close the window. 

7.2 Archiving Reports 
You may be required by law to keep certain financial reports for many years, but you do not want to 
keep everything you have ever printed for this long.  PETRA allows you to specify certain reports for 
Housekeeping to archive instead of deleting them.  Reports that have been archived are listed on the 
View Report Files Screen with ‘arc/’ in front the Report File Name. 

To set up archiving: 
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1. From the System Manager Screen, select Print Management and View Report 
Files . 

2. From the View Report Files Screen, select Archiving and Reports to Archive .  The 
Reports to Archive List Screen appears. 

3. Choose New .  The Reports to Archive Maintenance Screen appears. 

 

Figure 7-3 Reports to Archive Maintenance 

4. Report Title    is the title of the report you want to archive as it appears on the View Report Files 
Screen.  All reports whose titles begin with this text will be archived instead of deleted.  For 
example, entering Donor Gift Receipt  would allow reports entitled “Donor Gift Receipt”, 
“Donor Gift Receipt – Batch:16” and “Donor Gift Receipt – Batch:8 Trans:2” to be archived. 

5. Save  and Close the screen. 

7.3 Purge Expired Addresses 
When a Partner moves house, you use the Partner Module to set the date their old address expires.  
After a time, PETRA may contain a lot of these old addresses that no-one is using any more.  They are 
not removed automatically by Housekeeping, but you should do it manually on occasion.  It is not 
really a good idea to delete addresses as soon as they expire because you may still need to refer to an 
old address (for example to check a donation). 

To purge expired addresses: 

1. From the System Manager Screen, select File and Purge Expired Addresses .  The 
Purge Addresses Box appears. 
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Figure 7-4 Purge Addresses Box 

2. Enter the options you want: 

Date   addresses that expired after this date will not be deleted.  You may decide to purge 
addresses that expired one year ago. 

Show Report Only   tick this if you want a report of the addresses that expired before the chosen 
date, but do not want to delete them yet. 

3. Choose OK when you have finished. 

Note   this can take a long time.  Try to run it when the office is not busy. 

7.4 Temporary Files 
PETRA can generate a large number of files outside the database.  These are stored in the tmp 
directory. 

Version Tmp directory location 
Network /usr/local/samba/dat/petra/tmp22 

Standalone \Petra2\tmp22 

 

The tmp directory has two subdirectories: 

arc   is where archived reports are kept.  Do not delete anything from here, or you will lose the 
ability to reprint your archived reports. 

Caution   if you ever use the Linux ‘find’ command to delete files from the tmp directory, be very 
careful to tell it not to delete from the arc directory as well. 

export   is where files that are exported from PETRA go to by default, and where PETRA looks for 
files to import.  Of course, it is better if each user creates and maintains their own directory for 
PETRA files, and manages the files within it. 

Here is a description of the files you are likely to find in the tmp directory: 

File Name Type Description 
r???????.hdr 
r???????.rpt 
r???????.prt 
r???????.out 

Report files If you have any of these that are older than the 
reports listed on the View Report Files Screen 
then Petra has lost track of them and they will 
not be deleted by the report purge.  Be careful 
if you use the Linux 'find' command to delete 
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them: unless you use the '-maxdepth' parameter 
properly, it will descend into your 'arc' directory 
too and delete things you need to keep. 

*.rqf Email Control files Created when emailing reports.  For normal 
reports, these should be Deleted automatically 
along with the other report files, but the HOSA 
email uses a slightly different mechanism and 
the file may be left. 

*.log Log files Created mainly by patches.  They are not deleted 
automatically. 

p_* Export Partner and 
Extract files 

These are not deleted automatically.  Only the 
user who exported the data knows what it is for 
and how long it is needed. 

*.csv Finance Export files These are not deleted automatically because only 
the user who created them can say how long 
each file needs to be kept. 

*.txt HOSA files These are not deleted automatically. 

 

----- End of Chapter 7 ----- 
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Chapter 8 Patches 

The PETRA Development Team sometimes send out patches containing new versions of the program 
screens and updates to the data. 

To see which version of PETRA you have, select the Help menu from any screen and choose About 
Petra .  This will also tell you the program name and version for the screen you are on. 

 

Figure 8-1 About Petra 

If you want to see a list of all the patches that have been installed, choose Patches . 

 

Figure 8-2 Applied Patches 

On a Network version, you can also see the current patch from sysadm using sysadm petra22 
checkpatch (the current version) and sysadm petra22 checkpatches (the full list). 

When a patch is released we send out a notice to the petra-info email address at each field. The field 
I.T. Administrator needs to make sure that mail to this address is forwarded to everyone who needs it.  
This will include at least themselves, for the patches, and the Personnel Administrator, for notification 
of conference updates.  You can also use the Check Updates button, or the Petra Website 
button to visit the website and check for yourself. 

Patches are downloaded from the PETRA website, http://www.ict-software.org/petra/.  You need to 
download different files for the Network and Standalone versions.   

8.1 Installing the Files 
Before you start you should read the Release Notes that accompany the patch.  You can find these on 
the website with the patch files.  Tell your users that you are updating PETRA, and what changes they 
can expect. 
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8.1.1 Network 
PETRA needs to be shut down when installing a patch, so warn your users and make sure they log out.  
It only takes a couple of minutes. 

1. Download the network patch .zip file to T:\Programs\Petra2\bin22\net-patches. 

2. Log in as root on your server. 

3. Shut down PETRA. 

4. Run sysadm petra22 patchpetra . 

5. Restart PETRA. 

8.1.2 Standalone 
1. Log out of PETRA. 

2. Download the standalone patch .exe program and run it. 

8.2 After Patching 
Patches create a log file in the tmp22 directory (see ‘Housekeeping’ on page 43), named v_patch.log.  
You should check this file to see what the patch has done. 

 

----- End of Chapter 8 ----- 



System Manager Guide  Chapter 9   System Manager Reports 

Version 2.2 (1 Nov 2007)  Page 51 

Chapter 9 System Manager Reports 

This chapter lists the various reports that are available to the System Manager, dealing with the 
operation of PETRA and with data security. 

9.1 Partner Full Report 
It is the law in many countries that a person must be able to see all information that is stored about 
them in any computer database.  The Partner Full Report gives that information.  It is part of the 
System Manager Module because it requires high level access through all of PETRA.  To run the 
Partner Full Report: 

1. From the System Manager Screen, select File and Partner Full Report . 

 

Figure 9-1 Partner Full Report Box 

2. Select the options you want: 

Partner Key   if you want to print the report for a single partner, enter their key here, or choose 
the Partner Key button to bring up the Partner Find Screen. 

Extract    if you want to print it for all the partners in a particular extract, enter the name of the 
extract here, or choose the Extract button to bring up the Extract Master Find Screen. 

Note   printing the full report for an extract of partners can take a very long time. 

Print Details For Family Members   tick this if you want the details of all Person records 
attached to the Family you have chosen. 

Hide empty sections   tick this if you are printing a Person record and only want to see the parts 
of the Personnel Data Report that actually contain data. 

Print Financial Information    tick this if you want all financial details such as gifts. 

3. Choose OK. 
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9.2 Expired Addresses 
The Expired Addresses report has been dealt with in ‘Housekeeping’ on page 43.  Tick the ‘Show 
Report Only’ box if you only want the report. 

9.3 Tables Print 
This is a report of all the tables in the database, with a brief description and listing the level of access 
that the groups and users have to them.  To run it, select Security and Tables Print from 
the System Manager Screen. 

9.4 Current Users 
To see a list of who is currently logged in to PETRA, select Security and View Current 
Users  from the System Manager Screen. 

This report can be misleading, because it lists everyone who has logged on, but not logged off.  If a 
user does not log off properly, for example because their computer crashed, they will still be listed 
here.  To remove old entries, purge the Logins Log as below. 

On a network, a more reliable way to see who is logged in is to log in to your server as root and 
choose the ConnectedClients option from the sysadm petra22 screen. 

9.5 Logins Log 
The Logins Log is a list of everyone who has logged in, or tried to log in, to PETRA.  If you get a lot of 
failed login attempts, it may be a sign that someone is trying to break in. 

1. From the System Manager Screen, select Security and View Logins Log . 

 

Figure 9-2 View Logins Log Screen 

2. Choose Filter to view all the logins of a particular user, or between certain dates. 

3. To manually purge the log, enter the number of days you want to keep, select All if you want 
to purge all entries older than this or Successful if you want to keep the invalid entries even 
if they are older, then choose Purge . 
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9.6 Error Log 
The error log lists certain PETRA errors that have occurred. 

1. From the System Manager Screen, select Security and View Error Log . 

2. Again, you can filter the log by user or by date with the Filter button. 

3. To purge the log, enter the number of days you want to keep, and choose Purge . 

9.7 Report File Log 
This shows all reports that are available to be reprinted, when they were printed, who printed them, 
and the report file name.  You can find these files in the tmp directory (see ‘Chapter 7 
Housekeeping’).  If the report file name starts with ‘arc/’ then the report has been archived and its 
files will be found in the arc directory. 

1. From the System Manager Screen, select Print Management and View Report 
Files . 

2. To reprint a report, choose the Print button. 

3. To purge a single report, highlight the report, choose Selected Report and Purge .  To 
purge old reports, select Purge after and enter the number of days you wish to keep, then 
choose Purge . 

4. To set up the reports that you want to be archived instead of deleted, select Archiving and 
Reports to Archive from the menu (see ‘Housekeeping’). 

9.8 Database Log 
There are two logs of database activity kept outside of PETRA.  To view them on a Network system: 

1. Log in to Linux as root . 

2. Type sysadm petra22 and choose Administration . 

3. Choose ViewProgress  or ViewPetraServer . 

 

----- End of Chapter 9 ----- 
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Chapter 10 ODBC 

ODBC stands for Open DataBase Connectivity.  It provides a standard way for programs to connect to 
databases.  ODBC comes in two halves: driver and server.  A program like Microsoft Access or 
Crystal Reports will use the ODBC driver to connect to the ODBC server and get data from PETRA. 

10.1 ODBC Server 
On Network versions, the ODBC server is started and shut down as part of PETRA, and you can use 
both PETRA and an ODBC program at the same time. 

On Standalone versions, you can also use both at the same time, but you can also manually start the 
ODBC server when you want to use an ODBC program without running PETRA, and stop it when you 
have finished.  This was discussed in detail in ‘Startup and Shutdown’ on page 37. 

10.2 ODBC Driver 
The ODBC driver was installed and configured when you installed PETRA.  If you need to recreate or 
reconfigure it for any reason, follow these steps: 

1. Open the Windows Start Menu and choose Settings ► Control Panel . 

2. Choose Administrative Tools ► Data Sources (ODBC) .  When the ODBC Data 
Source Administrator appears, click the System tab. 

 

Figure 10-1 ODBC Data Source Administrator 

3. Choose Add or Configure.  When the Create New Data Source window appears, highlight 
DataDirect 4.1 32-Bit Progress SQL92 v9.1D  and choose Finish.  The ODBC 
Progress SQL92 Driver Setup window appears. 
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Figure 10-2 ODBC Progress SQL92 Driver Setup 

Enter the fields as shown.  For the Network version, Host Name should be the name of your 
server (usually linux ) and Port Number should be petrasqlsrv .  For a Standalone, Host 
Name should be localhost  and Port Number should be petrasqlsrv . 

4. Choose OK. 

Each user needs their own User ID and password.  These are different from the normal PETRA User 
ID's, and are administered using the separate ODBC User Manager program.  This can run from 
Start ► Programs ► Petra 2.2 ► ODBC User Manager .  The instructions are in the 
ODBC User Manager Manual, which is part of the online help within PETRA. 

 

----- End of Chapter 10 ----- 
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Chapter 11 Troubleshooting 

If you have trouble with PETRA, the first person you should contact is your AITA.  If your AITA 
cannot help, or if you are the AITA, you should email full details of your question or problem to 
petra-support@ict-software.org, including the version of PETRA and whether it is Network or 
Standalone.  Please also say if you need a secure reply. 

Here are some common questions and their answers: 

 

Why must I use petra-support@ict-software.org instead of the helpful person who answered my 
last question? 

There are 3 reasons for this.  If you send an email to one person, they may: 

1. Not be able to answer, and have to waste time forwarding it to the correct person. 

2. Be away on holiday, conference or campaign.  You could wait weeks for an answer. 

3. Have left the organisation.  You may not get an answer at all. 

When you send to petra-support, everyone on the Development Team sees it, so you know it has gone 
to the right person. 

 

What is the SYSADMIN password? 

It is given in the installation documentation on your CD.  We want to list it in as few places as 
possible for security reasons. 

 

I can’t log in!  PETRA says ‘Invalid User  ID/Password’ but I’m sure I typed them correctly. 

Check that the keyboard Caps Lock is turned off.  Remember that passwords are case sensitive. 

 

I’m trying to create a user, and I’m getting an error ‘You have given this user access to 
FINANCE but not to any ledgers’. 

This is not an error, it is just a reminder message.  You can still close the User Maintenance Screen by 
choosing Yes .  The user will still be able to run Petra, and create their own ledger if they are a 
member of the FINANCE-3 group.  They will not be able to use any existing ledgers, though, and 
must Cancel from the Select Ledger Box if it appears when they enter Finance. 

 

When I print labels, the margins are wrong and the addresses print off the labels. 

You have probably selected the wrong form on the Start Print Job Screen.  Select the form defined for 
these labels.  If you are selecting the correct form, check that the margins are correct on the Form 
Maintenance Screen. 

 

I’m trying to print using a particular form, but it  does not appear on the Start Print Job Screen. 

The form has not been assigned to the module you are printing from.  See ‘Assigning a Form to a 
Module’ on page 29. 

 

----- End of Chapter 11 ----- 
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Chapter 12 Advanced Configuration 

There are some extra configuration options that can be set to change PETRA’s behaviour.  Most of the 
time these options do not need to be changed. 

12.1 Automatic Detection of User ID 
PETRA detects the ID of the user logged in to Windows, and automatically fills in the User ID on the 
Petra Login screen to match.  On standalone systems where a default Windows user name is used, or 
on network systems where the network User IDs do not match the Petra ones, this is not always 
appropriate.  To prevent PETRA from filling in the User ID, edit the file 
C:\Petra2\ClientStandalone.config (standalone) or 
/usr/local/samba/app/Programs/Petra2/PetraClientNetwork.config (network).  Find the line 

<add key="UseWindowsUserID" value="true" /> 

and change it to 

<add key="UseWindowsUserID" value="false" /> 

12.2 Email Program 
PETRA will normally be able to detect the email program you have installed but there are 
circumstances when it may not be able to do so.  These include Pegasus Mail being run from the 
network F: drive without the installation program being run on the local computer.  To tell PETRA 
where to find Pegasus, edit /usr/local/samba/app/Programs/Petra2/petra22.ini (network) or 
C:\Petra2\petra22.ini (standalone).  Find the section called [Petra]  and add an item  

PegasusDir=f:\win95\pmail 

pointing to the folder where Pegasus should be run from. 

If you have Pegasus installed but want PETRA to try to use a MAPI-compliant email program instead 
(like Microsoft Word does), you can set 

PegasusDir=MAPI 

which causes PETRA to ignore Pegasus even if it does detect it.  PETRA does not need to be restarted 
after changing this parameter. 

12.3 Number Format 
When you installed PETRA you chose language and country settings, which included the format of 
numbers: whether to write one thousand point zero one in the American format of 1,000.01 or the 
European format of 1.000,01. 

If you find that the number format you are using is not suitable, you can change it by editing 
/usr/local/samba/app/Programs/Progress/startup.pf and /usr/local/progress/startup.pf (network) or 
C:\Program Files\Progress\startup.pf (standalone).  Network users need to edit two files, one for the 
client and one for the server.  In either case, there are two parameters that control the number format: 
-numsep  controls the thousands separator, and –numdec  controls the decimal character.  Set them 
to the ASCII codes of the characters you want as shown in the table below, and restart PETRA. 
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American Format 
1,000.01 

European Format 
1.000,01 

-numsep 44 

-numdec 46  

-numsep 46 

-numdec 44  

12.4 Number of Licensed Users 
This section is only relevant for network users.  You can see the number of users you are licensed for 
on the sysadm petra22admin screen.  To change it, select the ChangeLicense option.  You 
must have purchased the correct number of licenses through petra-admin@ict-software.org before 
changing this. 

After setting this option, you need to restart PETRA using sysadm. 

12.5 Watchdog Process 
The network version of PETRA runs an extra process, called the watchdog.  This is supposed to tidy 
things up in the event of a server process crashing (it does not help with workstation crashes).  
Unfortunately, it takes up one licensed user slot.  If necessary, it can be disabled by commenting out 
the line beginning $DLC/bin/prowdog in /etc/rc.d/init.d/petra22proserve and restarting PETRA. 

12.6 Website 
If you need to use a web proxy server instead of the normal PETRA website, change the Website  line 
in /usr/local/samba/app/Programs/Petra2/petra22.ini (network) or C:\Petra2\petra22.ini (standalone). 

 

 

----- End of Chapter 12 ----- 
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Index to System Manager Guide 

Tip   If using Adobe Reader to view online, you can jump to the page.  Find the item in the index, 
click in the page number box on the toolbar, type in the page number you want, and press 
[Return] .  This takes you immediately to the page. 
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Pegasus Mail Directory, 59 
Personal Name, 21 
petra.bak, 39 
petra.lk, 37 
petra-info, 49 
petra-support@ict-software.org, 57 
Print Details For Family Members, 51 
Print Financial Information, 51 
Purge 

Error Log, 43, 53 
Expired Addresses, 8 
Extracts, 43 
Logins Log, 43, 52 
Report Files, 43, 53 

Receipt Each Gift, 13 
Receipt Letter Frequency, 13 
reminders, 17 
Reports, 12 

purge, 8 
Report Banner, 13 
Report File Name, 44 
Report Title, 45 

Run command, 8 
Show Report Only, 46 
Site Key, 12, 16 

removing Sites, 11 
support. See petra-support@ict-software.org 
SYSADMIN, 19 

password, 7, 57 
user, 7 

System Manager Screen, 7 
tmp directory, 46, 50, 53 
Unit of Measure, 28 
User ID, 19, 21, 57 

Windows, 59 
User Maintenance, 7 
Users, number of, 60 
Wdog process, 60 
Width in Characters, 32 
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